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РЕФЕРАТ 

 

 

Магістерська робота: 79 с., 5 таблиць, 31 рисунків, 25 літературних джерел. 

Мета роботи – вивчення впливу просторової форми будівлі на ефективність 

її опалення методом модельного розрахунку. 

Відповідно до поставленої мети були вирішені такі задачі: 

– встановлено оптимальні параметри мікроклімату приміщення для 

забезпечення комфортних умов перебування людини; 

– розроблено математичну та числову модель теплового стану 

приміщення з обігрівом; 

– проведено моделювання процесів аеродинаміки та тепломасообміну в 

приміщенні для аналізу його теплового стану; 

– визначено раціональну просторову форму будівлі, що забезпечує 

комфортні умови перебування людини в приміщенні. 

 

Об’єкт дослідження – об’ємно-просторова форма будівлі. 

Предмет дослідження – тепломасообмінний процес у просторовій формі 

приміщення будівлі, яке нагрівається від опалювального приладу. 

Методи дослідження – вирішення поставлених задач проводилося з 

використанням методу модельного розрахунку з елементами комп`ютерної 

візуалізації та методу чисельного моделювання теплового стану приміщення в 

програмному продукті ANSYS CFX. 

Ключові слова: МАТЕМАТИЧНА МОДЕЛЬ, ЕНЕРГОЕФЕКТИВНІСТЬ, 

ТЕПЛОПЕРЕДАЧА, МОДЕЛЮВАННЯ. 

Тема роботи – «Вивчення впливу просторової форми будівлі на 

ефективність її опалення методом модельного розрахунку» 
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Перелік умовних позначень, індексів та скорочень 

 

 

ДБН – державні будівельні норми; 

ДНАОП – державні нормативні акти з охорони праці; 

ДСН – державні санітарні норми; 

КПО – коефіцієнт природного освітлення; 

рис. – рисунок; 

стор. – сторінок; 

табл. – таблиця; 

і т.д – і та далі. 

 

 

Застарілі назви 

 

 

ГОСТ – государственный общесоюзный стандарт; 

ОНТП – общесоюзные нормы технологического проектирования; 

СНиП – строительные нормы и правила; 
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ВСТУП 

 

 

У сучасному середовищі нашого проживання дуже відчутними стають 

енергетичні проблеми людства, які значною мірою одночасно з політичною 

кризовою ситуацією зумовлюють економічний та матеріальний рівень життя 

регіонів і країни в цілому. Енергія, є одним з найважливіших продуктів в 

індустріальному суспільстві. Як і всі природні ресурси, енергетичні ресурси 

можуть виснажитися, тому важливо заощаджувати якомога більшу кількість 

енергії [1]. 

 Енергозбереження як діяльність (організаційна, наукова, практична, 

інформаційна), спрямована на раціональне використання енергії і природних 

енергетичних ресурсів, – державна проблема, яка постала на порядок денний 

слідом за найважливішою політичною подією в житті України – кризою. Тож 

саме комплексне розв’язання проблеми енергозбереження є найбільш прийнятним 

для України шляхом подолання енергетичної кризи . 

Проектування енергоефективних будівель, окрім скорочення тепловтрат 

через огороджувальні конструкції за рахунок оптимізації пропорцій, вимагає 

дотримання естетичної виразності їх фасадів, а також гармонізації пропорцій 

будівель. Оскільки в процесі мінімізації тепловтрат архітектурного об’єкта досить 

часто потерпає саме естетичний аспект такого впровадження. Натомість 

геометрична форма будівлі при оптимальних пропорціях з точки зору тепловтрат 

через огороджувальні конструкції може мати не достатньо архітектурну та 

естетичну виразність. 

Для збільшення енергоефективності з планувальної точки зору 

малоповерхові будівлі повинні проектуватися максимально компактними і з 

меншою порізаністю фасаду. Це дозволить скоротити площу зовнішніх 

огороджень і знизити тепловтрати в зимовий період і теплонадходження в літній 

період. Таким чином, чим менше відношення площі огороджувальних 

конструкцій до обсягу будівлі, тим менш схильне будівлю впливам клімату. 
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Виходячи з вищенаведеного, у даній роботі визначена мета дослідження, а 

саме, вивчення впливу просторової форми будівлі на ефективність її опалення 

методом модельного розрахунку. 

Відповідно до визначеної мети поставлені наступні до вирішення задачі: 

– встановити оптимальні параметри мікроклімату приміщення для 

забезпечення комфортних умов перебування людини; 

– розробити математичну та числову модель теплового стану приміщення з 

обігрівом; 

– провести моделювання процесів аеродинаміки та тепломасообміну в 

приміщенні для аналізу його теплового стану; 

– визначити раціональну просторову форму будівлі, що забезпечує 

комфортні умови перебування людини в приміщенні. 

Методи дослідження – вирішення поставлених задач проводилося з 

використанням методу модельного розрахунку з елементами комп`ютерної 

візуалізації та методу чисельного моделювання теплового стану приміщення. 
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1 ХАРАКТЕРИСТИКА АКТУАЛЬНОСТІ ТЕМИ ДОСЛІДЖЕННЯ 

 

 

1.1 Особливості проектування енергоефективних будівель 

 

 

Енергоефективною вважається будівля, в якій при проектуванні, 

будівництві та експлуатації здійснено максимальну кількість заходів, направлених 

на економію паливно-енергетичних ресурсів. 

Основними шляхами економії енергії в житлових будівлях є підвищення 

теплової ефективності будівельних конструкцій, архітектурно-планувальних 

рішень, об’ємно-планувальних рішень, інженерних систем, застосування 

нетрадиційних видів енергії. 

Досягнути цього можна такими заходами: збільшенням теплозахисту стін, у 

тому числі стиків, вікон, горищ і т. п., покращенням вологісного режиму 

зовнішніх огороджень, зменшенням площі зовнішньої поверхні будівель, 

проектуванням фасадів з врахуванням вітрового захисту, раціональним 

плануванням приміщень, застосуванням більш осучаснених систем опалення та 

вентиляції, автоматизацією систем опалення з по-фасадним регулюванням, 

автоматизацією мікроклімату будівлі, утилізацією тепла витяжного повітря, що 

виходить через зовнішні захисні конструкції. 

Створення енергоефективних будівель пов’язано з удосконаленням усіх 

його складових елементів. 

Одним із основних напрямків підвищення теплової ефективності будівлі є 

об’ємно-планувальні рішеня. Об’ємно-планувальні рішення мають істотний вплив 

на енергоспоживання будівлі. Вибір оптимальної форми будинку, його орієнтації, 

розташування, оптимізації площі вікон залежно від перерозподілу світла у 

глибину приміщень, дозволяє зменшити негативний теплоенергетичний вплив 

зовнішнього клімату на тепловий баланс будівлі. 
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Процес проектування енергоефективних будівель повинен починатися з 

аналізу об’ємно-планувальних рішень. 

Енергозберігаючі об’ємно-планувальні рішення житлових будинків 

забезпечуються [2]: 

• збільшенням протяжності корпусу будівлі з урахуванням містобудівних 

умов (збільшення протяжності будинку з 4 до 10 секцій спричиняє зниження 

питомої витрати теплоти на опалення до 5 ... 7%); 

• збільшенням ширини корпусу з урахуванням нормативних вимог щодо 

освітленості приміщень (збільшення ширини корпусу спричиняє зниження 

питомої витрати теплоти з 12 до 15 м на 9... 10%); 

• оптимізацією поверховості (підвищення поверховості будівлі з 5 до 9 

поверхів дає 3 ... 5% економії теплоти); 

• скороченням площі поверхні зовнішніх стін за рахунок зменшення 

порізаності об’єму будівлі; 

• збільшенням сумарної площі квартир на поверсі; 

• відносним зменшенням периметра будівлі (зменшення питомого 

периметру (відношення периметра зовнішніх стін до загальної площі типового 

поверху) зовнішніх стін на кожні 0,01 м призводить до зменшення витрати тепла 

на 1,25 ...2%); 

• раціональною аеродинамікою забудови (зменшенням швидкості вітру в 

зоні забудови можна скоротити в 2...3 рази інфільтраційні тепловтрати будівлями, 

що рівноцінно економії 0,1 кг у. п. на 1 м
2
 загальної площі на рік); 

• оптимальним розташуванням приміщень різного призначення в залежності 

від орієнтації фасаду. 

• застосуванням планувальних елементів, що сприяють підвищенню 

теплоефективності житлового будинку; 

Забезпечення енергоефективності багатосекційних житлових будинків за 

рахунок збільшення виходу площі на поверсі секції рекомендується здійснювати : 

• у житлових будинках з прямими рядовими або поворотними секціями ‒  за 

рахунок збільшення ширини секції на торці; 
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• у житлових будинках з широтними Т-подібними секціями ‒  за рахунок 

збільшення кількості квартир на поверсі до 6-8; 

• у кутових секціях (з кутом повороту на 90°) ‒  за рахунок розміщення по 

зовнішньому світловому фронту максимальної кількості квартир. 

• у житлових будинках (секційного, коридорного, коридорно-секційного та 

галерейного типів) за рахунок збільшення виходу сумарної площі житла на 

поверсі, яке забезпечує підвищення їх енергоефективності та може бути 

досягнуто: 

• у широтних будівлях ‒  за рахунок застосування квартир з великою 

кількістю кімнат, а також за рахунок збільшення кількості квартир на поверсі 

секції; 

• у протяжних меридіональних будинках (у тому числі зі здвигом у плані) ‒  

за рахунок збільшення кількості квартир на поверсі та зменшення питомого 

периметру зовнішніх стін. 

До заходів з підвищення теплової ефективності згідно з нормативними 

вимогами відносять: зменшення зрізаності зовнішніх стін зі зменшенням 

показника питомого периметра зовнішніх стін до 0,25 м/м
2
 загальної площі і 

менше, збільшення ширини корпусу будівлі за рахунок збільшення глибини 

кімнат та кухонь; для кухонь допускається зменшення ширини при однорідному 

розміщенні обладнання до 1,9 м; максимально можливе зменшення площі 

світлових прорізів; створення блок-секцій. 

Можна виділити декілька типів вихідних об’ємно-планувальних рішень: 

точковий, лінійний, терасний і т. п. Зменшення тепловтрат точкових будівель 

досягається створенням компактних (близьких до квадрата) планувальних рішень, 

збільшенням їх розмірів в плані.  

Лінійні будівлі з меридіальною орієнтацією поздовжньої осі мають 

дворядне блокування квартир, що дозволяє організувати широкий корпус, 

підвищує теплову ефективність будівлі. Дворядне блокування квартир сприяє 

зменшенню інфільтрації холодного повітря. Удосконалення форм лінійних 

будівель з широтною орієнтацією полягає в збільшенні протяжності корпусів і 
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застосуванні максимально можливої поверховості. Для зменшення втрат тепла до 

північної стіни можуть бути прибудовані, наприклад, гаражі, господарські 

приміщення, виконано блокування квартир з утворенням замкнутого контуру 

забудови. 

На теплову ефективність терасного типу будівлі впливають крутість схилу, 

а також конфігурація квартир, розміщення їх вздовж або поперек схилу, розміри в 

плані, конфігурація заглиблених в ґрунт та зовнішніх стін, орієнтація схилу. В 

терасних будівлях меридіальної орієнтації економія тепла досягається дворядним 

блокуванням квартир двосторонньої орієнтації, забезпеченням великої глибини 

квартир, розміщенням по схилу максимальної кількості поверхів, зменшення 

інфільтрації досягається застосуванням квартир без наскрізного провітрювання. 

Рекомендуються: 1 три-, чотириточкові будівлі з чотирьох – восьми блоків 

(квартири в декількох рівнях); 2 три-, п’ятиповерхові односекційні будівлі з 

чотирма – шести квартирами на поверсі (прямокутної конфігурації); 3 чотири-, 

п’ятиповерхові будівлі комбінованої плану-вальної структури (з терасним 

розміщенням Г-подібних блоків квартир) лінійної, лінійно-розгалуженої, 

подвоєної забудови. Доцільним є застосування будівель з об’ємно-планувальними 

рішеннями, що відрізняються збільшеною глибиною корпусу. Рекомендуються 

три-, чотириповерхові блоковані будівлі з прямокутних блоків великої (більше 10 

м) протяжності двосторонньої орієнтації; три-, чотириповерхові блок-секції; 

чотири-, шестиквартирні меридіальної орієнтації з центрально розміщеною 

сходовою кліткою; три-, п’ятиповерхові будівлі комбінованої планувальної 

структури, секційно-галерейні (коридорні), секційно-блоковані або галерейно-

блоковані, в тому числі з атріумними квартирами в першому поверсі. 

Найменш комфортні – секційні, найбільш – блоковані.  

Підвищення комфорту в будівлях секційно-планувальної структури можна 

досягти шляхом збільшення площі літніх приміщень (лоджії або веранди), 

організацією при квартирах перших поверхів ділянок з виходами  на них з 

квартири; розширення складу додаткових підсобних приміщень та їх розміщення 

на поверхах (наприклад, на цокольному поверсі). 
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Ефективним планувальним прийомом в житлових будівлях є створення 

системи природної вентиляції шляхом збільшення частини приміщень (так звана 

"Сонячна труба") та розміщення вентиляційних отворів як в нижній, так і в 

верхній зонах. Організація вертикальних повітряних потоків в житлових будівлях 

дозволяє, практично, без спеціальних технологічних обладнань створити 

ефективну систему провітрювання та обігріву житлового простору, тому 

отримують широке розповсюдження двосвітлові, атріумні простори в житлових 

будівлях. 

Для збільшення енергоефективності з планувальної точки зору 

малоповерхові будівлі повинні проектуватися максимально компактними і з 

меншою порізаністю фасаду. Це дозволить скоротити площу зовнішніх 

огороджень і знизити тепловтрати в зимовий період і теплонадходження в літній 

період. Таким чином, чим менше відношення площі огороджувальних 

конструкцій до обсягу будівлі, тим менш схильне будівлю впливам клімату. 

Одним із прикладів енергоефективних малоповерхових будівель є 

ширококорпусні будинки. Головна їхня особливість полягає в збільшеній ширини 

корпусу (до 23,6 м) з дотриманням всіх норм інсоляції та повітрообміну. У цьому 

випадку відношення корисної житлової площі до площі зовнішніх стін 

збільшується, а теплові втрати знижуються на 20-40% [3]. 

Інноваційними є купольні (сферичні) будівлі (рис. 1.1). 

 

Рис. 1.1 Приклад енергоефективної будівлі в вигляді купола 
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Ідеальною формою енергоефективного будинку є півсфера, звернена зрізом 

до землі. Форма сфери має найменше відношення площі зовнішніх стін до 

внутрішнього об'єму будівлі, що забезпечує економію будівельних матеріалів і 

скорочення витрат на опалення і кондиціонування на 70-90% [4]. Крім цього 

купол має на 60-70% менше деталей в каркасі конструкції, відрізняється 

світловими характеристиками, так як сферична форма має властивість розсіювати 

світло, а завдяки аеродинамічному ефекту конструкції вітер огинає купол з 

меншим опором, крім того, купольна конструкція є ідеальним варіантом для 

установки сонячних батарей і використання альтернативних джерел енергії. 

Суміщені в одній конструкції коло і купол складають стіни, перекриття та 

покрівлю. Така конструкція в разі виготовлення зі збірних елементів і «м'яких» 

матеріалів стійка до динамічних навантажень і сніговим заметів [4]. 

Універсальність купольної споруди дозволяє вписати його практично в будь-який 

ландшафт, а також прибудувати до нього додаткові кімнати такої ж форми. До 

недоліків купольної конструкції можна віднести дорогі рішення, пов'язані з 

віконними прорізами, а також необхідність вибору просторого ділянки для 

будівництва. Така конструкція вимагає проведення грамотних і точних 

розрахунків геодезичного купола. Оптимальними матеріалами для купольної 

будівлі є дерево, а також бетон. 

 

 

1.2 Обґрунтування напряму дослідження 

 

 

На сьогоднішній день головними проблемами будівель є підвищені витрати 

теплової енергії на опалення та невідповідність внутрішнього мікроклімату 

приміщень загальноприйнятим нормам комфорту [5].  

Основними архітектурно-планувальними та об'ємно-просторовими 

рішеннями, спрямованими на енергозбереження [6], є: 
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 вибір оптимальної форми будівель, яка характеризується зниженим 

коефіцієнтом компактності та забезпечує мінімальні тепловтрати в зимовий 

період і мінімальні теплонадходження в літній період року; 

 вибір оптимальної орієнтації будівель по сторонах світу з 

урахуванням напрямку вітру в зимовий період з метою нейтралізації негативного 

впливу клімату на будівлі і його тепловий баланс; 

 вдосконалення архітектурно-планувальних рішень житлових будинків 

з широким корпусом, що дозволяють значно знизити тепловтрати; 

 скорочення площі зовнішніх огороджувальних конструкцій шляхом 

зменшення периметра зовнішніх стін за рахунок відмови від порізаності фасадів, 

виступів і т. д.  

 максимальне скління південних фасадів і мінімальне скління 

північних фасадів будівель; 

 установка додаткових тамбурів при входах в будівлю; 

 установка доводчиків вхідних дверей; 

 максимальне використання природного освітлення приміщень для 

зниження витрат електричної енергії; 

 зв'язок приміщень без зайвих коридорів, холів і темних приміщень. 

Вище наведені рішення доводять той факт, що у джерелах проектування 

будівель повинні бути закладені основні технологічні і архітектурні рішення, 

застосовані з наявного досвіду проектування, а також розташування об'єктів на 

генеральному плані (містобудівні рішення). Крім того, проект повинен нести 

спільну ідею зниження енерговитрат в сукупності з проектувальником, 

застосованих і розрахованих на моментах загальної концепції забудови . 

Враховуючи вищенаведену інформацію, постає питання з більше 

досконального вивчення впливу просторової форми будівлі на рівень 

енергоефективності при її експлуатації. Таким чином, визначена актуальність у 

подальшому досліджені тепломасообмінних процесів під впливом архітектурної 

форми як самих будівель, так і окремих їх приміщень. 
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2 ВИЗНАЧЕННЯ ВИХІДНИХ ДАНИХ, ТА ЇХ ХАРАКТЕРИСТИКА 

 

 

2.1 Характеристика об’єкту та предмету дослідження 

 

 

При оцінці ефективності функціонування систем теплозабезпечення 

використовують інтегральний якісний показник теплового комфорту людини. 

Тепловий комфорт визначається мікрокліматом у приміщенні, який у свою чергу 

характеризується температурами повітря і внутрішніх поверхонь приміщення, 

вологістю повітря і швидкістю його руху [7]. Нормальне тепловідчуття людини 

визначається комплексним показником, який враховує температуру повітря в 

приміщенні і середню радіаційну температуру. Під радіаційною температурою 

розуміють осереднену за площею температуру внутрішніх поверхонь приміщення 

і опалювальних приладів. Значення параметрів мікроклімату слід обирати 

залежно від призначення приміщення, категорії робіт і пори року, виходячи з 

вимог комфорту для людей, що знаходяться всередині, і штатного протікання 

технологічного процесу. 

Підтримання заданих параметрів мікроклімату у приміщенні на 

відповідному рівні в холодний період забезпечує система опалення. За способом 

тепловіддачі розрізняють конвективні і променисті (радіаційні) системи опалення. 

До конвективних відносять систему опалення, при якій температура повітря 

підтримується на більш високому рівні, ніж радіаційна температура (у цьому 

випадку найбільш поширеними нагрівальними приладами є радіатори і 

конвектори різних конструкцій). Променистим вважають опалення, при якому 

радіаційна температура приміщення перевищує температуру повітря (до 

променистого опалення відносяться інфрачервоне опалення та опалення, яке 

здійснюється за допомогою вбудованих панелей із нагрівальними елементами у 

вигляді труб або електричних кабелів) [8]. 

Таким чином, у даній роботі визначено об’єкт та предмет дослідження: 
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Об’єкт дослідження – об’ємно-просторова форма будівлі. 

Предмет дослідження – тепломасообмінний процес у просторовій формі 

приміщення будівлі, яке нагрівається від опалювального приладу.  

Для проведення чисельного експерименту моделі теплового балансу 

будівель було створено тривимірні моделі приміщень за допомогою програмного 

продукту SolidWorks (рис. 2.1). 

В даній роботі необхідно визначити розподіл температури по будівлі  

 

а) б) 

в) г) 

 

Рисунок 2.1 – Тривимірна модель будівель: 

а) сферична; б) циліндрична; 

в) пірамідальна; г) прямокутна.  

 

Розміри тривимірних моделей будівель наведені в таблиці 2.1. 
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Таблиця 2.1 Розміри тривимірних моделей будівель: 

Область Ширина, м Довжина, м Висота, м Об’єм, м
3
 

Сферична модель 5,232 5,232 5,232 300 

Циліндрична 

модель 

4,886 4,886 4,000 300 

Пірамідальна 

модель 

12,410 12,410 5,85 300 

Прямокутна модель 7,500 10,000 4,000 300 

 

Розрахунковою областю в даній задачі є об’єм приміщення, який 

складається з області повітря та системою опалення. 
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2.2  Визначення способу проведення дослідження та його характеристика 

 

 

Вирішення поставлених задач проводилося з використанням методу 

модельного розрахунку з елементами комп’ютерної візуалізації та методу 

експериментального дослідження на фізичній моделі предмета дослідження. 

На сьогодні, існує велика кількість програмних комплексів для дослідження 

потоків вимірюваного середовища. Деякі з них наведені нижче: 

 STAR-CCM+ - призначений для розв'язання задач механіки суцільних 

середовищ. Забезпечує весь процес моделювання завдання. Простота  

у використанні і автоматизації підготовки CAD-моделей, сітки, що дозволяє 

інженерам домагатися кращих результатів швидше і точніше. 

 NUMECA FINE - розрахунковий програмний комплекс загального 

призначення для вирішення CFD задач гідродинаміки, газодинаміки, 

аеродинаміки (чисельного моделювання складних внутрішніх і зовнішніх течій). 

Використання даного інструменту скорочує час підготовки завдання  

до розрахунку і спрощує роботу інженера за рахунок автоматичної побудови 

високоякісних гексаедральних сіток. 

 PumpLinx - програмний інструмент 3D моделювання, призначений 

для аналізу і проектування насосів, електродвигунів, компресорів, повітряних 

гвинтів, клапанів, гідравлічних систем і пристроїв управління рідинами з 

обертовими або розсувними компонентами. Може бути використаний для 

підвищення загальної ефективності проектованих пристроїв, зниження рівня 

кавітації, зменшення амплітуди пульсацій, контролю тиску, а також зниження 

рівня шуму. 

 FlowVision - багатоцільове комплексне рішення для моделювання 

тривимірних течій рідини і газу, які включають у себе закони збереження маси, 

імпульсу (рівняння Нав'є-Стокса), рівняння стану. Для розрахунку складних рухів 

рідини і газу, супроводжуваних додатковими фізичними явищами, такими, як, 
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турбулентність, горіння, пористість середовища, теплопередача, у математичну 

модель включаються додаткові рівняння, що описують ці явища. 

 ANSYS — універсальна програмна система кінцево-елементного 

аналізу, що існує та розвивається на протязі останніх 30 років, є досить 

популярною у фахівців у сфері автоматизованих інженерних розрахунків і 

рішення лінійних і нелінійних, стаціонарних і нестаціонарних просторових задач 

механіки деформаційного твердого тіла та механіки конструкцій (включаючи 

нестаціонарні геометрично і фізично нелінійні задачі контактної взаємодії 

елементів конструкцій), задач механіки рідини і газу, теплопередачі і 

теплообміну, електродинаміки, акустики, а також механіки зв'язаних полів. 

На сьогоднішній день в наукових дослідженнях особливої популярності 

набули методи чисельного моделювання гідродинамічних процесів на базі 

обчислювальної гідродинаміки. Аналіз сучасних методів обчислювальної 

гідродинаміки показує, що одним з найбільш прогресивних програмних пакетів 

для дослідження потоку теплоносія є ANSYS. 

Система ANSYS - це гнучкий і надійний засіб проектування та аналізу.  

Вона працює в середовищі операційних систем найбільш поширених комп'ютерів. 

Особливістю програмної системи є файлова сумісність усіх членів родини ANSYS 

для всіх використовуваних платформ. Багатоцільова спрямованість програми 

(тобто реалізація в ній засобів для опису реакції або реакції складної системи на 

впливи різної фізичної природи) дозволяє використовувати одну й ту ж модель 

для вирішення таких пов'язаних завдань, як міцність при теплових 

навантаженнях, вплив магнітних полів на міцність конструкції, 

тепломасоперенесення у електромагнітному полі. Забезпечує всім користувачам 

ANSYS зручні можливості для вирішення широкого кола інженерних завдань [9]. 

У даний час програмна система ANSYS являє собою багатоцільовий пакет 

проектування та аналізу, визнаний у всьому світі. 

Можна виділити наступні етапи проведення гідродинамічного аналізу:  

– розробка моделі;  

– встановлення параметрів моделювання; 
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– отримання результатів;  

– обробка результатів. 

При розробці моделі здійснюється підготовка геометричної моделі, 

задаються матеріал приладу і тип вимірюваного середовища та їх властивості, 

відбувається генерація елементної сітки, визначаються фізичні умови 

моделювання. Результат етапу - модель, підготовлена для чисельного розв’язку.  

На етапі, встановлення параметрів моделювання і отримання результатів, 

задаються необхідні параметри моделювання, що забезпечують збіжність 

ітераційного процесу, і запускається модель для отримання результатів. Кінцевим 

результатом етапу є чисельний розв’язок, отриманий із заданою точністю. 

Отриманий чисельний розв’язок задачі на етапі обробки результатів 

використовується для візуалізації розподілу необхідних фізичних величин (тиску, 

швидкості, температур та ін.) Результатом етапу є набір графіків, анімацій, 

масивів значень, що представляють необхідні результати вирішення 

завдання [10]. 

В роботі використовуються такі програми [11]: 

1. CAD - Система автоматизації проектних робіт (САПР) або CAD (англ. 

Computer-Aided Design) - програмний пакет, призначений для створення креслень, 

конструкторської та / або технологічної документації та / або 3D моделей [12]. 

2. ANSYS CFX-Pre - додаток, в якому реалізований процес визначення 

фізики поставленого завдання. 

3. ANSYS CFX-Solver - програма, що реалізує процес вирішення 

завдання обчислювальної гідродинаміки. 

4. ANSYS CFX-Post - це програма, призначена для аналізу, візуалізації і 

представлення результатів, отриманих в результаті виконання завдання за 

допомогою ANSYS CFX Solver. 
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2.3 Опис розрахункової моделі 

 

 

Для задання параметрів розрахункової області розрахункова сітка була 

імпортована в модуль Препроцесор CFX-Pre (рис. 2.2).  

 

 

Рисунок 2.2 – Розрахункова область в Препроцесорі 

 

В Препроцесорі задаються умови однозначності (крайові умови) та 

вибираються математичні моделі, які необхідні для чисельного вирішення задачі 

(створюється розрахункова модель). За допомогою Препроцесора створювалася 

розрахункова модель складного теплообміну (радіаційно-конвективного) в 

розрахунковій області, тобто описані процеси конвективного теплообміну, що 

супроводжуються тепловим випромінюванням.  

Конвективний теплообмін – процес перенесення теплоти як конвекцією так 

і теплопровідністю.  
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Конвекція – це процес перенесення теплоти при переміщенні мікрочастинок 

тіла в просторі із зони з однією температурою в зону з іншою температурою.  

Теплопровідність – процес перенесення теплоти внаслідок хаотичного руху 

та енергетичної взаємодії між мікрочастинками, з яких складається тіло (молекул, 

атомів, електронів); вона не залежить від руху тіла або його частин.  

Теплове випромінювання (променистий теплообмін) – це процес 

перенесення теплоти електромагнітними хвилями, зумовлений тільки 

температурою і оптичними властивостями випромінювального тіла.  

За променистого теплообміну відбувається подвійне перетворення енергії: 

спочатку внутрішня енергія тіла, що випромінює енергію, перетвориться на 

променисту енергію, яка передається в середовище, доки на своєму шляху не 

натрапить на непрозоре тіло, у якому відбувається процес перетворення 

променистої енергії на внутрішню енергію. В цій задачі розрахунковою областю є 

об’єм, який займає повітря в приміщенні тому конкретно буде розглядатися 

процес передачі тепла від поверхонь твердих стінок (опалювальних приладів, 

стін, підлоги, стелі) до повітря (складна тепловіддача). При цьому теплота 

переноситься конвекцією завдяки контактові стінок з повітрям, що їх обтікає, і ті 

самі стінки випромінюють і поглинають енергію, обмінюючись потоками 

випромінювання з повітрям і навколишніми предметами. 

Зазначені вище процеси розповсюдження теплоти в розрахунковій області 

являються нестаціонарними (змінюються в часі), тому проведений розрахунок в 

стаціонарній постановці (приведений до певного моменту в часі).  

Для математичного визначення даної задачі задавалися умови 

однозначності (крайові умови) [13], що містять: 

– геометричні умови, які характеризують форму і розміри тіла 

(розрахункової області); 

– фізичні умови, які характеризують фізичні властивості тіла (густина, 

в’язкість, теплопровідність тощо); 

– часові умови, які формують особливості перебігу процесу в часі 

(задаються для нестаціонарного процесу); 



  

23 

 

– граничні умови, що характеризують умови протікання процесу на межах 

тіла (розрахункової області).  

Геометричні розміри і форма розрахункової області автоматично 

визначаються модулем Препроцесор, так як дана геометрична модель представляє 

собою структуровану сітку. 

Робочим тілом в даній розрахунковій області є повітря, термодинамічні 

параметри якого наведені в табл. 2.2. 

 

Таблиця 2.2 – Термодинамічні параметри повітря 

Назва параметру Розмірність Чисельне значення 

Молярна маса кг

Кмоль
 28,96 

Густина 3кг м  1,284 

Питома теплоємність (р = сonst) Дж

кг К
 1003,8 

Тиск атм 1 

Коефіцієнт теплового розширення 1К  0,00366 

Динамічна в’язкість Па с  1,725·10
-5

 

Коефіцієнт теплопровідності Вт

м К
 2,428·10

-2
 

Коефіцієнт поглинання 1м  0,01 

Коефіцієнт розсіювання 1м  0 

  

Граничні умови можна задавати трьома способами. В даному випадку 

застосовувалися граничні умови першого роду. За граничних умов першого роду 

задавався розподіл температури на поверхні стінки сТ  для кожного проміжку 

часу : 

 

(2.1) 

 

де , ,x y z  – координати поверхні тіла (рис. 2.2); 

, , , ,сТ f x y z
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Оскільки ми не розглядали проміжок часу, то приймалося, що температура 

на поверхні твердих стінок залишається величиною сталою, а рівняння (2.1) 

набуває вигляду: 

 

сТ const .      (2.2) 

 

Граничні умови на кожному з елементів приведені в табл. 2.3. 

 

Таблиця 2.3 – Граничні умови 

Тверда стінка Температура поверхні, К С  

Опалювальний прилад (radiator) 358 (85) 

Підлога (floor) 289 (16) 

Стеля (top) 291 (18) 

Стіни (wall) 291 (18) 

 

Усі тверді стінки були прийняті шорсткими, середнє арифметичне 

відхилення профілю (Ra) складало 25 мкм. 

При розрахунку використовувалась модель гравітації, яка дозволяє 

врахувати процес вільної (природної) конвекції в замкнутому об’ємі, що 

обумовлена дією масових (об’ємних) сил. Масові сили – сили, що прикладені до 

всіх частинок речовини і дією поля гравітації. Природна конвекція виникає під 

час теплообміну внаслідок теплового розширення нагрітого біля поверхні 

тепловіддачі повітря (різниці густин нагрітих і холодних об’ємів середовища). 

Інтенсивність теплового розширення повітря характеризується температурним 

коефіцієнтом об’ємного (теплового) розширення [14]: 
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1

P const

v

v T
,     (2.3) 

де 
1

v  – питомий об’єм повітря, 
3м

кг
;  

 – густина повітря, 
3

кг

м
. 

Для повітря коефіцієнт об’ємного розширення можна наближено отримати, 

користуючись рівнянням Клапейрона [14]: 

 

1

Т
.     (2.4) 

Запишемо значення коефіцієнта об’ємного розширення через різницю 

питомих об’ємів та густини [14]: 

 

1 1
,

p p

p p p

v v

v t t Kt t
,    (2.5) 

 

де pv  – питомий об’єм холодного повітря,  

р  – густина холодного повітря,  

рt  – температура холодного повітря,  

v  – питомий об’єм прогрітого повітря,  

 – густина прогрітого повітря,  

t  – температура прогрітого повітря. 

Наявність різниці густин призводить до того, що на будь-який одиничний 

об’єм прогрітого повітря діятиме підіймальна сила ПF , яка дорівнює алгебраїчній 

сумі виштовхувальної архімедової сили: 

 

pA g        (2.6) 
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і сили ваги [14]: 

 

G g        (2.7) 

 

3
, .p p pП

Н
F A G g g t t

м
   (2.8)

 

 

Підіймальна сила ПF  переміщує прогріте повітря вгору так і виникає 

природна конвекція. В даній задачі наша розрахункова область побудована в 

просторових координатах , ,X Y Z  (рис. 2.2), тому для врахування моделі гравітації 

по координатній осі Y  було задано значення прискорення вільного падіння g: 

 

29,81, .Y g м с     (2.9) 

 

Задавалися наступні значення швидкості руху повітря в приміщенні на 

початку прогрівання: 

 

0,XU м с ;     (2.10) 

0,YU м с ;     (2.11) 

0,ZU м с .     (2.12) 

 

Швидкість по всім трьом координатам рівна нулю, отже в даній задачі 

розглядалося переміщення повітря залежно від різниці температур на поверхнях 

твердих стінок (опалювальні прилади, стіни, стеля, підлога і тд.). 

Для вирішення задачі використовувалась модель теплообміну в постановці 

(Thermal Energy [11]), що включає сукупність транспортних рівнянь: 

нерозривності, імпульсу, повної енергії (збереження енергії). Зазначені рівняння в 

подальшому використовуються для вирішення теплового енергетичного рівняння. 

Рівняння нерозривності, імпульсу, збереження енергії в стаціонарній структурі 

(операторному вигляді) мають вигляд: 
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 рівняння нерозривності [15]: 

 

0U
t

,    (2.13) 

 

де U  – вектор швидкості , , ,X Y ZU м с . 

– рівняння імпульсу [15]: 

 

M

U
U U p S

t
,   (2.14) 

 

– рівняння повної енергії [15]: 

 

tot

tot M E

h p
U h T U U S S

t t
. (2.15) 

 

В цьому рівнянні toth  – повна ентальпія, що пов’язана зі статичною 

ентальпією ,h T p  [15]: 

 

21

2toth h U .     (2.16) 

 

Параметр U  характеризує роботу в’язких зусиль і називається 

в’язкісним терміном роботи. Параметр MU S  характеризує роботу впливу 

зовнішніх джерел імпульсу і в даному випадку не враховується. 

Для того щоб отримати альтернативну форму енергетичного рівняння 

знаходимо значення механічної енергії [15]: 

 

21

2
K U .     (2.17) 
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Механічне енергетичне рівняння отримано як скалярний добуток U  з 

рівнянням імпульсу [15]: 

 

M

K
U K U p U U S

t
. (2.18) 

 

Якщо відняти дане рівняння від рівняння повної енергії то отримаємо 

теплове енергетичне рівняння [15]: 

 

: E

h
U h T U p U S

t t
.  (2.19) 

 

Параметр : U  завжди є додатнім і названий в’язкими втратами. З 

подальшими допущення, що описані вище, отримуємо спрощене теплове 

енергетичне рівняння [15]: 

 

: E

h
U h T U S

t
.   (2.20) 

 

Дане рівняння також може бути отримане з попереднього рівняння якщо h  

фактично інтерпретується як внутрішня енергія [15]: 

 

P
e h .     (2.21) 

 

Тоді рівняння теплової енергії запишеться в даному вигляді (еквівалентне 

рівняння теплової енергії) [15]: 

 

: E

e
U e T p U U S

t
. (2.22) 
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Дане рівняння еквівалентне рівнянню теплової енергії коли не враховується 

параметр p U  і h  інтерпретується як e . Основним параметром являється 

статична ентальпія хоч фактично представляє собою внутрішню енергію. 

Визначальним параметром являється 
P

 за допомогою якого підбираються 

значення з таблиць ентальпії. 

Для випадку, що розглядається, для потоків з низькими значеннями числа 

Маха параметри 
p

t
 та U p  не враховуються оскільки мають дуже незначний 

вплив. 

 В даній задачі рівняння теплової енергії хоч і являється спрощеним, але 

дозволяє добре описати протікання теплообмінних процесів у газовому 

середовищі (повітря). 

 Окрім цього модель теплообміну (Thermal Energy) доповнюється моделлю 

вихрової дифузії (Eddy Diffusivity) [15]. Дана розрахункова модель розроблена на 

основі гіпотези Бусінеска [16]. Ця гіпотеза пояснює зростання величини 

гідравлічного тертя при переході від ламінарного режиму руху до турбулентного. 

Бусінеск висунув гіпотезу проте що в турбулентних потоках виникає особлива 

властивість – турбулентна в’язкість t . За Бусінеском в узагальнений закон 

Ньютона замість звичайної (молекулярної) в’язкості  необхідно підставляти 

суму t . Також окрім турбулентної в’язкості був введений показник 

турбулентної теплопровідності t , яка характеризує турбулентний перенос 

теплоти. Турбулентна в’язкість визначається з врахуванням турбулентного 

напруження як [16]: 

 

i j

i j
t

uu

u x
,     (2.23) 

 

де i ju u
 – осереднений добуток пульсацій швидкостей по координатам; 
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i ju u
 – напруженість Рейнольдса, характеризує турбулентне перенесення 

імпульсу в приграничному шарі.  

Турбулентна теплопровідність визначається з врахуванням турбулентного 

теплового потоку як [16]: 

 

j

j

p
t

c u T

T x
,    (2.24) 

 

де ju T  – осереднений добуток пульсацій швидкості та температури; 

jpc u T  – параметр що визначає турбулентний перенос теплоти. 

Разом з величинами t  та t  в розрахунках використовуються кінематична 

турбулентна в’язкість t t  та турбулентна температуропровідність 

t t pa c . Це дозволяє перейти до безрозмірних критеріїв [13]: 

– турбулентне число Прандтля: 

 

Pr
t pt

t
t t

c

a
;     (2.25) 

 

– турбулентне число Шмідта: 

 

t
t

t

Sc
Г

.     (2.26) 

 

Дані критерії характеризують співвідношення процесів турбулентного 

переносу імпульсу, речовини та тепла в повітрі. Так як коефіцієнти t  та t  

теоретично розрахувати неможливо то для цього і використовується модель 

вихрової дифузії (Eddy Diffusivity) на основі гіпотези Бусінеска. В даній моделі 

задавалися слідуючі значення турбулентних критеріїв: 
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Pr 0,9t ;     (2.27) 

 

0,9tSc .     (2.28) 

 

 Вибір даних значень критеріїв пояснюються численними 

експериментальними дослідженнями, які показали, що дані числа для газових 

середовищ (повітря) можуть набувати значень від 0,7 до 1,0 по поверхні 

пограничного шару, найбільш точне значення при заданих умовах наближається 

до 0,9. 

Бусінеск знайшов співвідношення між напруженістю Рейнольдса та 

в’язкими зусиллями тензора деформації через параметр турбулентної 

в’язкості [15]:  

 

2

3i

ji k
t tj ij

j i k

U UU
u u k

x x x
.   (2.29) 

 

 За даною гіпотезою потоки скаляра Рейнольдса лінійно зв’язані зі 

скалярним градієнтом [15]: 

 

ti
i

Ф
u Г

х
,     (2.30) 

 

де  – загальна скалярна змінна; 

Pr
t

t
t

Г  – вихрова (турбулентна) дифузійна здатність, 
кг

м с
. 

Наведені вище рівняння можуть описати  турбулентні коливання за 

допомогою функцій скупих змінних і тільки якщо відома турбулентна в’язкість. 

k  модель турбулентності з двома рівняннями використовує показник 

турбулентної в’язкості t . Тоді згідно наведеної гіпотези рівняння імпульсу 

запишеться як [15]: 
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ji i
i j Meff

j i j j i

UU Up
U U S

t x x x x x
,  (2.31) 

 

де MS  – сума масових сил,
2 2

кг

м с
; 

teff
 – ефективна в’язкість. 

Модифікований тиск визначається як [15]: 

 

2 2

3 3
k

eff
k

U
p p k

x
,    (2.32) 

 

де 
2

3
k

eff
k

U

x
 – параметр, що характеризує розбіжність швидкостей (в 

даній задачі не враховується так як використовується тільки для нестискуваних 

речовин (вода)). 

Рівняння енергії відповідно поданої моделі запишеться як [15]: 

 

Pr
tot t

totj i ij i j E
tj j j j j

h p T h
U h U u u S

t t x x x x x
 (2.33) 

Аналогічно наведемо транспортне рівняння для додаткових змінних [13]: 

 

t
j Ф Ф

j j Ф

Ф
U Ф Г S

t x x
,   (2.34) 

 

де ФГ  – динамічна дифузійна здатність додаткової змінної, 
кг

м с
; 

Ф  – додаткова змінна, 
3

кг

м
. 
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Слід зазначити те, що хоч і трансформація параметрів молекулярної дифузії 

може являтися неточною, але турбулентні параметри є правильними згідно моделі 

вихрової дифузії (Eddy Diffusivity). Крім того, оскільки турбулентна дифузія 

являється набагато більшою ніж молекулярна то незначні помилки в останній 

ігноруються. 

Модель переміщення повітря в розрахунковій області описувалася 

рівняннями Нав’є-Стокса осередненими за числом Рейнольдса. Відповідно до цієї 

модель швидкість iU  розкладається на два компонента: компонент осередненої 

швидкості iU  та компонент зміни в часі iu  [15]: 

 

ii iU U u .      (2.35) 

 

Осереднений компонент швидкості визначається як [15]: 

 

1
t t

i i

t

U U dt
t

,     (2.36) 

 

де t  – проміжок часу, що являється великим відносно турбулентних 

коливань, але малим відносно проміжку часу для якого вирішуються рівняння, с . 

Відповідно до цього запишемо енергетичне рівняння Нав’є-Стокса, що 

осереднене за числом Рейнольдса [15]: 

 

tot
totj j i ij i j E

j j j j

h p T
U h u h U u u S

t t x x x x
. (2.37) 

 

Аналогічно додаткова змінна Ф  розкладається на осереднений компонент 

Ф  та компонент зміни у часі  і записується Нав’є-Стокса, що осереднене за 

числом Рейнольдса для додаткової змінної [15]: 
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j j Ф
j j j

Ф Ф
U Ф Г u S

t x x x
.  (2.38) 

 

В заданій розрахунковій області будуть протікати турбулентні режими течії. 

Турбулентність складається із коливань в області потоку в часі та просторі. 

Турбулентність – це складний процес тому що являється тривимірним, нестійким, 

залежить від багатьох факторів і значний ефект на специфіку потоків. 

Турбулентність виникає коли сили інерції в речовині стають значними порівняно 

з силами внутрішнього тертя і характеризуються великими числами Рейнольдса. 

Пряме чисельне моделювання турбулентних потоків потребує обчислювальної 

потужності такої, яка на багато порядків являється більшою ніж буде доступною в 

найближчому майбутньому. А для того щоб включити ефекти турбулентності 

використовують методи, що включають моделі турбулентності. 

В розглядуваній задачі для вирішення рівнянь Нав’є-Стокса осереднених за 

числом Рейнольдса використовується k  модель турбулентності. Дана модель 

заснована на гіпотезі дифузії градієнта для того, щоб пов’язати зусилля 

Рейнольдса із швидкісними градієнтами та турбулентною в’язкістю. Турбулентна 

в’язкість змодельована як функція, що залежить від турбулентної швидкості та 

турбулентної шкали відстаней. Турбулентна шкала відстаней залежить від 

властивостей області турбулентності та кінетичної енергії турбулентності k  

(визначається як дисперсія коливань швидкості). Дана модель пов’язує 

турбулентну в’язкість та кінетичну енергію турбулентності через відношення 

[15]: 

 

2

t

k
C ,     (2.39) 

 

де 0,09C  – константа моделі турбулентності. 
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При використанні цієї моделі система рівнянь руху доповнюється двома 

диференціальними рівняннями, що описують перенесення відповідно кінетичної 

енергії турбулентності k  і швидкості дисипації  [15]: 

 

t
j k kb

j j jk

k k
U k P P

t x x x
;  (2.40) 

1 2 1
t

j k b
j j jE

U C P C C P
t x x x k

;  (2.41) 

 

де 1 21,44; 1,92; 1,0; 1,3
k

С С  – константи моделі турбулентності. 

Зсув турбулентності через вплив сил внутрішнього тертя моделюється [15]: 

 

2
3

3
ji i k k

t tk
j i j k k

U U UU U
P k

x x x x x
.      (2.42) 

 

В розглядуваній задачі враховувалося перенесення тепла випромінюванням 

(радіаційний теплообмін). Запишемо рівняння, що враховує розповсюдження 

тепла випромінювання має вигляд [15]: 

 

4
4

v sv
av sv v av vb

dI K
K K I K I v T dI Ф d S

ds

r,s
r,s , r,s s s ,  (2.43) 

 

де v  – частота випромінювання; 

r – радіус-вектор; 

s – направляючий вектор; 

– довжина проміню випромінювання; 

avK  – коефіцієнт поглинання; 

svK  – коефіцієнт розсіювання; 

b
I  – інтенсивність випромінювання чорного тіла; 
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vI  – спектральна інтенсивність випромінювання, що залежить від довжини 

та напрямку дії променя випромінювання; 

T  – абсолютна температура; 

 – тілесний кут; 

Ф  – функція внутрішнього розсіювання; 

S  – інтенсивність джерела випромінювання. 
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3 РЕЗУЛЬТАТИ РОЗРАХУНКУ ЗАДАЧ ЗА ВИЗНАЧЕНОЮ 

МЕТОДИКОЮ 

 

 

3.1 Виконання розрахунку теплового балансу будівель 

 

 

В результаті чисельного дослідження теплового стану приміщення були 

отримані основні параметри в розрахунковій області при виході на 

стаціонарний режим процесу складної тепловіддачі (тобто за досягнення 

максимальної і стабільної у часі температури повітря). Опис виконання 

чисельного дослідження приведено для одного варіанту просторової форми 

будівлі, а саме для прямокутної. Розрахунки для циліндричної, пірамідальної 

та сферичної форми будівель проводилися за аналогічною методикою. 

 

 

3.1.1 Побудова 3-D моделі  

 

 

Для проведення чисельного експерименту моделі теплового балансу 

приміщення було створено тривимірну модель приміщеня за допомогою 

програмного продукту SolidWorks (рис. 3.1). 

Будуємо модель будівлі. Для спрощення розрахункової сітки побудова 

приладу опалення полягала у вирізані його граней. Будували не будівлю, а об`єм 

повітря в будівлі. 
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Рисунок 3.1 – Тривимірна модель приміщення: 

 

 

3.1.2 Побудова розрахункової сітки 

 

 

Для виконання чисельного дослідження побудована розрахункова сітка. 

Побудова розрахункової сітки – це процес ділення розрахункової області на 

велику кількість окремих комірок. Розрахункова сітка – це основа всього 

розрахунку. Якщо сітка не якісна, то розрахунок може мати велику похибку або 

не запуститися взагалі. 

Комірками сітки є багатогранники, зазвичай тетраедри, гексаедри, призми 

або піраміди (рис. 3.2). Кромки цих осередків (комірок) є лініями розрахункової 

сітки, а точки, розташовані на кромках, або в центрі осередків (комірок), – вузли 

розрахункової сітки. В результаті чисельного розв’язання рівнянь математичної 

моделі саме у вузлах розрахункової сітки і визначаються шукані параметри течії. 

 

 



  

39 

 

    

Гексаедр Піраміда Призма Тетраедр 

 

Рисунок 3.2– Типові форми осередків (комірок) сітки 

 

Основна вимога до розрахункової сітки – вона повинна бути досить густою, 

щоб визначити фізичні ефекти, які мають місце усередині розрахункової області. 

Для досягнення рівномірної точності розрахунку вузли сітки повинні якомога 

більш густіше розташовуватися у місцях значної зміни параметрів течії, зокрема у 

стінок. Крім того, при побудові сітки необхідно уникати отримання надмірно 

витягнутих або перекошених осередків (комірок), форма яких занадто сильно 

відрізняється від правильних багатогранників. Якість розрахункової сітки впливає 

на точність отриманих результатів, збіжність результатів, об’єм необхідних 

ресурсів, які будуть затрачені комп’ютером (об’єм оперативної пам’яті) та час 

необхідний для вирішення задачі.  

Для побудови структурованої сітки розрахункова область розбивається на 

блоки згідно деякої топології розбиття, яка задається користувачем, і в межах 

кожного блока будується розрахункова сітка, на вузли якої можна посилатися за 

номерами 3-мірного масиву. Застосування такої сітки дозволяє організувати 

найбільш економічні алгоритми розрахунку. 

Будуємо 3D модель будівлі в програмі «SolidWorks». В програмі 

«SolidWorks»  зберігаємо будівлю, вибираючи тип файла Parasolid Binary (*.x_b).  

Для створення розрахункової сітки використовуємо програмний продукт 

ANSYS ICEM CFX - комплексне рішення для задач генерації розрахункових сіток 

будь-яких типів, від структурованої багатоблокової до неструктурованою гекса- 

або тетраедричних або гібридної.  
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Відкриваємо програму ANSYS ICEM CFX →папку Meching→ICFX CFD. 

Створюємо папку File→New Project→Square  і створюємо в папці файл 

Square_MESH. Імпортуємо геометрію File→Import Geometry→Parasolid. 

Вибираємо Millimeter→Apply. Вмикаємо Points, Curves.  

Щоб показати тіло, вибираємо дві точки, які лежать в розрахунковій 

області.  

Заходимо в закладку Geometry, створюючи тіло заходимо в вкладку Create 

Body та вибираємо дві точки, середньою клавішею миші підтверджуємо, а правою 

виходимо з команди. BODY повинно знаходитися в розрахунковій області, 

показуючи що будуємо сітку в середині поверхні. 

Вимикаємо BODY та Points. Розбиваємо нашу геометрію на частини на яких 

будемо задавати граничні умови. Створюємо частини: в дереві побудови  

знаходимо закладку Parts правою кнопкою миші вибираємо Create Part, далі на 

нашій геометрії вибираємо curves і points. 

Відображаємо поверхні, натискаємо в дереві на Surfaces правою клавішею 

миші та вибираємо Solid. 

Розділяємо аналогічно стелю, підлогу, стіни та опалювальний прилад. 

Parts→Create Part→top, floor, wall, radiator. Вмикаємо в дереві Surfaces, 

натискаємо правою клавішею миші та вибираємо опцію Transparent та робимо 

будівлю прозорою. Назви частин та поділ можемо бачити на рисунку 3.2. 
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Рис. 3.2 Розподіл поверхонь 

 

Починаємо створювати блоки. Заходимо в закладку Blocking→Create 

Block→ в першу закладку та вибираємо геометрію повністю. 

Підсвітилися криві та з`явилися кути блоку, автоматично асоційовані на 

точки блоку, автоматично асоціювалися лінії на криві будівлі. 

Додатково в ручну асоціюємо кути, щоб при різані на блоки вони не 

перескочили на інше місце. Заходимо в закладку Associate→Associate Vertex та 

натискаємо на кути будівлі по два рази. 

Вибираємо блок в дереві по Blocks правою клавішею миші вибираємо Solid 

та підсвічуємо блок. 

Вибираємо Split Block→першу вкладку та ріжемо по лініям на блоки. 

Ріжемо по вертикалі, вибираємо горизонтальне ребро  тримаючи лівою клавішею 

миші переміщаємо і шукаємо куди потрібно поставили поблизу точок та 

відпускаємо, підтверджуємо середньою клавішею миші, а правою виходимо з 

команди. Включаємо поверхні, щоб будо видно, що порізали, а що ні. Для 

видалення блоку натискаємо Delete Block. 
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Створюємо сітку для цього необхідно вибирати всі поверхні. В дереві 

активуємо Pre-Mesh з`являється вікно Mesh, натискаємо Yes. Вибираємо закладку 

Mesh→Surfaces Mesh Setup. Вибираємо всю розрахункову область. В Maximum 

size-100; Height-100 та натискаємо Apply. У результаті отримуємо попередній 

варіант розрахункової сітки (рис. 3.3). 

 

Рис. 3.3 Попередній варіант розрахункової сітки 

 

Переходимо в закладку Blocking→Pre-Mesh Params→Update All→Apply. 

По Pre-Mesh правою клавішею миші та вибираємо Solid x Wire. 

Заходимо Blocking→Pre-Mesh Params та вибираємо Edge Params. Для 

кращої якості сітки робимо плавні переходи між вузлами. Застосовуємо закон 

розподілення вузлів. Blocking→Pre-Mesh Params→Mesh law→BiGeometric, 

згущаємо з обох сторін ребра. Вибираємо ребро та збільшуємо кількість вузлів 

Nodes, Spacing – 10; Ratio – 1,2; Max Space: 50-60, ставимо галочку напроти Copy 

Parameters→Apply. Включаємо Pre-Mesh→Yes. По висоті також розбиваємо, 

вибираємо ребро по висоті. Перпендикулярно осі Х по осі Z. Перпендикулярно осі 

Y по осі X. 
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Для оцінки якості використовувалися наступні критерії: quality (якість рис. 

3.4), determinant 2х2х2 (детермінант 2х2х2, рис.3.5). Blocking→Pre-Mesh 

Quality→Apply.  

 

 

Рис. 3.4 – Діаграма якості області повітря 

 

 

Рис. 3.5 – Діаграма якості (детермінант) області повітря 

 

Створюємо сітку. File→Mesh→Load from Blocking→Replace. (рис3.6) 

 

Рисунок 3.6 – Розрахункова сітка для будівлі. 
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Запишемо файл сітки. Output→Solver Setup→вибираємо ANSYS CFX, 

ANSYS, ставимо галочку напроти Set As Defauk→Apply. 

Вибираємо останню закладку Write input→Yes. З`являється віконце 

зберігання файлу сітки, потрібно обов`язково масштабувати, напроти Scaling 

ставимо Yes, в тисячу раз зменшуємо 0,001→Done. 

Так як в роботі необхідно розраховувати 4 просторових форм будівлі, 

запишемо для них основні параметри отриманої розрахункової сітки області 

повітря (табл. 3.1). 

 

Табл. 3.1 Кількість елементів та вузлів в розрахункових сітках 

Модель Кількість елементів Кількість вузлів 

Сферична модель 115 800 111 889 

Циліндрична модель 656 182 633 942 

Пірамідальна модель 421 900 405 600 

Прямокутна модель 136 484 129 109 

 

 

3.1.3 Побудова розрахункової моделі 

 

 

Для виконання чисельного дослідження повинна бути створена 

розрахункова модель. Створення розрахункової моделі виконується в окремому 

модулі – Пре-Процессорі, який має назву «CFX-Pre».  Для створення 

розрахункової моделі необхідно виконати: 

1) В Пре-Процесор інтегруються розрахункові сітки елементів 

розрахункової області.  

2) Визначається вид чисельного дослідження: в стаціонарній постановці 

або в нестаціонарній постановці. 

3) Визначаються моделі фізичних процесів та течії. 
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4) Визначаються параметри і характеристики елементів розрахункової 

області. Елементи можуть бути стаціонарними та такими які обертаються. 

5) Визначаються граничні умови. 

6) Визначаються параметри розрахунку. 

7) Після створення розрахункової моделі в Пре-Процесорі, необхідно 

зберегти дані в файлі розрахунку (файл з розширенням *.def). 

Для виконання чисельного розрахунку повинні буди визначені граничні 

умови на вході і виході розрахункової області, а також граничні умови на 

поверхнях, які є граничними для розрахункової області. Можуть 

використовуватися наступні типи граничних умов: 

- вхід (inlet). В якості граничної умови на вході можуть бути визначені: 

швидкість течії, масова витрата, статичний тиск, повний тиск, та ін. Даний тип 

означає умову, що течія направлена в середину розрахункової області; 

- вихід (outlet або opening). Якщо на виході робочої області наявна течія з 

одностороннім напрямком, в такому разі можливо обрати тип граничної умови 

outlet. Якщо на виході робочої області течія може мати двосторонній напрямок, 

необхідно обирати тип opening.  

- тверда стінка (wall). Тип граничної умови, який визначається як тверда 

непроникна стінка і передбачає умову дорівнювання швидкості нулю. 

- симетрична границя (simmetry). Ця умова визначає симетрію течії 

відносно границі, на якій позначена дана умова. 

Заходимо ANSYS → CFX → CFX-Pre. Створюємо новий проект. 

Імпортуємо сітку: в дереві натискаємо правою клавішею миші по Mesh→Import 

Mesh→ICEM CFD та знаходимо сітку та натискаємо Open.  

Створюємо розрахункову модель, тобто задаємо умови (початкові, 

граничні) та модель течії. Заходимо в дереві Analysis Type та обираємо режим 

розрахунку - стаціонарний  Steady State→OK.   

Задаємо розрахункову область Domain та називаємо її Square→OK.  



  

46 

 

В першій вкладці Basic Setting в Location and Type вибираємо 

Assembly→OK. У вкладці Material задаємо параметри оточення із бібліотеки Air 

Data→Air at STP→OK.  

Задаємо модель плавучості, щоб розрахувати конвекцію повітря від 

нагрівання радіатора. Для цього задаємо прискорення вільного падіння. 

Вибираємо Buoyant, по X=0; Y= -9.81м/с
2
; Z=0 та задаємо відносну температуру 

22 . 

Переходимо в закладку Fluid Models, задаємо модель течії рідкого оточення. 

В Heat Transfer вибираємо модель теплопередачі Thermal Energy. Модель течії 

обираємо k-Epsilon. З`явилася модель повітря. 

Таким чином ми задали робочу область. Тепер задаємо граничні і початкові 

умови. 

На панелі інструментів знаходимо Boundary, вибираємо in Air, називаємо 

Floor→OK. 

В першій вкладці в Boundary Type вибираємо Wall, в Location вибираємо 

Floor→OK.  

Заходимо в другу вкладку Boundary Details та вибираємо шорсткість Wall, 

ставимо 25 мікрон. Задаємо температуру Temperature, 16 →OK.  

Заходимо Boundary та вибираємо шорсткість Wall, ставимо 25 мікрон. 

Задаємо температуру Temperature, 18 →OK.  

Заходимо Boundary та вибираємо шорсткість Top, ставимо 25 мікрон. 

Задаємо температуру Temperature, 18 →OK.  

Заходимо в Boundary та вибираємо шорсткість Radiator, ставимо 25 мікрон. 

Задаємо температуру Temperature, 85 →OK.  

Зберігаємо та називаємо square_pre з розширенням cfx файл розрахункової 

моделі. 

Заходимо Solver Control та збільшуємо кількість ітерацій, до 10 000. 

Заходимо Output Control в другій вкладці Backup створюємо Backup Result 

1та в Iteration Interval ставимо 20, щоб записувалася кожна 20 ітерація →OK. 
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У вкладці Monitor – Monitor Points and Expressions задаємо рівняння для 

знаходження середньої температури по всьому об’єму будівлі: 

 

volumeAve(Total Temperature )@Square   (4.1) 

 

Зберігаємо файл розрахункової моделі з розширенням cfx та називаємо 

Square_pre. Заходимо у вкладку Write Solver Input File та зберігаємо з 

розширенням def. 

 

 

3.1.4 Виконання розрахунку 

 

 

Розрахунок виконується в окремому модулі, який має назву «CFX-Solver 

Manager». Заходимо в Launcher→CFX-Solver Manager , Define Run (рис. 3.7) 

 

Рисунок 3.7 – Запуск розрахунку в CFX-Solver Manager 
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Для проведення комп’ютерних розрахунків використовувалась комплексна 

програма CFX-Solver Manager 16.2 Дана програма вирішує задані в розрахунковій 

моделі рівняння методом поступових наближень. Дана задача розраховувалась в 

стаціонарній постановці. В закладці Solver Input File завантажуємо файл з 

розширенням def.→Open та натискаємо Start Run. Після того як розпочався 

розрахунок, результат його ходу можемо бачити на декількох вкладках, що 

показують параметри та функцію кожної обрахованої комірки, в результаті чого 

можемо робити висновки про вірність розрахунків даної кімнати (рис. 3.8-3.11). 

 

 

Рисунок 3.8 – Графік сходження рівнянь швидкостей і маси 
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Рисунок 3,9 – Графік сходження рівняння теплопереносу 

 

 

Рисунок 3,10 – Графік сходження рівнянь моделі турбулентності 
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Рисунок 3,11 – Графік сходження значень температури повітря 

 

Для повного розрахунку нам знадобилося всього 700 ітерацій. Як бачимо, 

критерії збіжності повністю не зійшлись; графік, що знаходиться у вкладці User 

points не вийшов на пряму лінію, проте розрахунок вийшов на стаціонарний 

режим, тобто різкі зміни не відбуваються впродовж подальшого розрахунку, а 

отже можемо вважати розрахунок завершеним та вірним. 

 

 

3.1.5 Вивід та аналіз результатів розрахунку 

 

 

Заходимо ANSYS→CFX 16.2→CFD-Post 16.2. File→Load Results 

File→вибираємо файл з розширенням res→Open. У вікні Domain Selector 

вибираємо square→OK. Починаємо зі створення однієї поверхні Surface Group 1, 

куди входять стіни, підлога, стеля та опалювальний прилад. Робимо її 

півпрозорою, щоб краще виділялися межі кімнати. Оскільки в кімнаті були задані 



  

51 

 

температури стелі, стін, підлоги та опалювального приладу то ми можемо чітко 

спостерігати цей розподіл в кольоровому представленні на рисунку 3.12. 

 

 

Рисунок 3.12– Розподіл температур в кімнаті, що задані як вихідні дані 

 

Температури поверхонь, задаються для того, щоб краще проходив процес 

тепломасообміну і чіткіше спостерігалася зміна температур в кімнаті. 

Створюємо поверхню. Location→Plane та називаємо її Plane 1 (вертикальна 

площина посередині)→OK.  

В першій вкладці Geometry в Domains вибираємо All Domains, в Method – 

XY Plane→Apply. У другій вкладці Color, в Mode вибираємо Constant→Apply. 

Вимикаємо в дереві Plane 1. Створюємо контур на цій площині. Заходимо в 

закладку Contour, називаємо Contour 1→OK. 

В першій вкладці в Domains вибираємо All Domains, в Locations вибираємо 

Plane 1→OK, в Variable вибираємо Temperature, в Range – User Specifiled, в of 

Contours задаємо 21→Aplly.(рис. 3.13) 
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Рисунок 3.13 – Осереднена температура по кімнаті 

 

Вимикаємо контур в дереві Default Legend View 1. Натискаємо в дереві по 

площині Plane 1 правою клавішею миші та вибираємо Duplicate, називаємо  Plane 

2→OK. 

Переходимо в цю площину. В першій вкладці Geometry в Domains 

вибираємо All Domains, в Method – ZX Plane в Z задаємо 1 м →Aplly.  

В другій вкладці Color, Mode→Constant →Apply. 

Показуємо рух повітря в кімнаті. Створюємо ізолінії Insert Streamline→OK. 

В першій вкладці вибираємо в Type→3D Streamline, в Domains→All Domains, в 

Start From→floor, of Points→75→Apply. (рис. 3.14) 
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Рисунок 3.14– Рух повітря по всій будівлі 

 

Переходимо до другої вкладки Appearance, в Text Parameters вибираємо 

Fixed→Apply. Робота з картинкою. Заходимо File→Save Picture, вибираємо 

Format→JPEG, активуємо White Background, Image Quality-100, заходимо File і 

називаємо рисунок→Save.  

В дереві натискаємо по Plane . Осереднюємо температуру по всій поверхні. 

Заходимо Function Calculator, в Function→areaAve (осереднити по площині) в 

Location вибираємо Plane 1, Variable→Temperature та натискаємо Calculate. 

Осереднена температура 291К.  

Швидкість повітря (рис. 3.14) розподіляється  таким чином: тепле повітря 

від приладу опалення піднімається до стелі та рівномірно розподіляється по її 

поверхні та по стінам знижується до підлоги.  
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3.2 Порівняння результатів розрахунків  

 

Для порівняння розрахунків розглянемо розподілення температур по всіх 

просторових форм будівель, які досліджуються. 

Сферична форма будівлі: 

На рисунку 3.15 зображено розподіл температури по вертикальній площині 

яка проходить посередині будівлі. 

 

 

Рис. 3.15 Розподіл температури повітря по висоті будівлі 

 

На рисунку 3.16 зображено швидкість повітря на вертикальній площині яка 

проходить посередині будівлі. 
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Рис. 3.16 Швидкість повітря по висоті будівлі 

 

На рисунку 3.17 зображено рух повітря на по всій будівлі. 

 

 

Рисунок 3.17– Рух повітря по всій будівлі 
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Циліндрична форма будівлі: 

На рисунку 3.18 зображено розподіл температури по вертикальній площині 

яка проходить посередині будівлі. 

 

Рис. 3.18 Розподіл температури повітря по висоті будівлі 

 

На рисунку 3.19 зображено швидкість повітря на вертикальній площині яка 

проходить посередині будівлі. 

 

Рис. 3.19 Швидкість повітря по висоті будівлі 
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На рисунку 3.20 зображено рух повітря на по всій будівлі. 

 

Рисунок 3.20– Рух повітря по всій будівлі 

 

Пірамідальна форма будівлі: 

На рисунку 3.21 зображено розподіл температури по вертикальній площині 

яка проходить посередині будівлі. 

 

Рис. 3.21 Розподіл температури повітря по висоті будівлі 
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На рисунку 3.22 зображено швидкість повітря на вертикальній площині яка 

проходить посередині будівлі. 

 

Рис. 3.22 Швидкість повітря по висоті будівлі 

 

На рисунку 3.23 зображено рух повітря на по всій будівлі. 

 

Рисунок 3.23– Рух повітря по всій будівлі 
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Прямокутна форма будівлі: 

На рисунку 3.24 зображено розподіл температури по вертикальній площині 

яка проходить посередині будівлі. 

 

Рис. 3.24 Розподіл температури повітря по висоті будівлі 

 

На рисунку 3.25 зображено швидкість повітря на вертикальній площині яка 

проходить посередині будівлі. 

 

Рис. 3.25 Швидкість повітря по висоті будівлі 
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На рисунку 3.26 зображено рух повітря на по всій будівлі. 

 

Рисунок 3.26– Рух повітря по всій будівлі 

 

Проведене розрахункове моделювання надало можливість отримати 

зображення розподілу швидкості руху повітря всередині будівлі, розподілу 

температурних полів, показник середньої температури повітря по всьому об`єму 

будівлі. 

Розподіл температури повітря по висоті будівлі показано на рис. 3.27. 

 

Рисунок 3.27 – Графік залежності температури по висоті будівлі 
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При прогріві будівлі опалювальним приладом бачимо, що тепле повітря 

підіймається вгору та розподіляється по всій будівлі симетрично. Сферична 

форма будівлі має найкращі показники розподілу температури в кімнаті так як 

біля стелі не має кутів, а тому тепле повітря плавно опускається донизу; розподілу 

температури по висоті будівлі  

 

 

3.3 Характеристика напряму використання результатів дослідження 

 

 

Життя сучасної людини немислиме без певного рівня комфортності 

приміщень. Будь-яку сучасну будівлю не можна розглядати без інженерних 

систем забезпечення мікроклімату (теплопостачання, опалення, вентиляція, 

кондиціювання) та комунально-побутових потреб (водопостачання, 

водовідведення, електро- та газопостачання). Сама архітектура будинку, його 

орієнтація, взаємодія з розташованими поруч іншими будинками і спорудами 

також впливають на роботу інженерних систем. Будівельні конструкції, 

різноманіття систем вироблення, транспортування енергії, безпосередньо робота 

систем опалення, нерівномірність надходжень і втрат тепла, вологи в самих 

приміщеннях, їхній взаємовплив - вимагають їх аналізу і врахування з погляду 

комфортності та енергозбереження.  

Саме тому, приймаючи рішення про будівництво, майбутній власник в 

якості одного з першочергових питань приймає рішення про те який майбутній 

будинок буде на вигляд, як він буде опалюватися та при якому архітектурному 

рішенні він буде найенергоефективнішим. 

Отримані результати даного дослідження допоможуть вибрати правильну 

форму будівлі та один із способів її опалення. 
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4 ОХОРОНА ПРАЦІ ТА БЕЗПЕКА В НАДЗВИЧАЙНИХ СИТУАЦІЯХ 

 

 

4.1 Аналіз небезпечних і шкідливих факторів об’єкту дослідження  

 

 

Об’єктом дослідження є робочий кабінет в адміністративній будівлі.  

Опалювана площа кімнати становить близько 75 м
2
. Приміщення має 3 

внутрішніх стіни та одну, що контактує з зовнішнім середовищем. Стіни мають 

товщину 400 мм. Стеля приміщення представляє собою залізобетонну 

конструкцію товщиною 260 мм. У кабінеті є підвісна стеля (металопрофіль з 

гіпсовою плиткою). Стеля контактує з другим поверхом, режим опалення якого 

аналогічний режиму опалення кімнати, що досліджується. Підлога покрита 

лінолеумом. Вікно, що знаходиться в кабінеті,  виконане з пластикового профілю 

ПВХ. 

Ширина кімнати без рахування стін становить 7,5 м, довжина 10,0 м, висота 

кімнати 4 м. Об’єм кабінету 300 м
3
. Площа та об'єм приміщення, що припадають 

на 6 чоловік відповідають  СНиП 2.09.04-87 [17]. Цим документом установлено, 

що на кожного працюючого повинно припадати  в управлінських приміщеннях не 

менше 4 м
2
 робочої площі. Висота приміщення від підлоги до стелі повинна бути 

не менше 2,5 м. 

У приміщенні знаходяться шість комп'ютерів, три сканера та три принтера. 

Джерелом живлення служить електрична мережа з напругою 220 В. Дане 

приміщення за ступенем небезпеки ураження електричним струмом відноситься 

до категорії приміщень без підвищеної небезпеки. В приміщення 

використовується природна вентиляція. Використовується природне і штучне 

освітлення. Розташування джерел штучного освітлення виконано так, щоб 

виключити можливість прямого попадання світла в очі. Стан світлових прорізів 

гарне - чисте прозоре скло не перешкоджає проходженню сонячних променів.  
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Розглянемо більш детально небезпечні та шкідливі фактори, які діють на 

людину під час роботи в адміністративній будівлі.  

 

 

4.1.1 Електрична небезпека 

 

 

Першочерговим небезпечним фактором є електрична небезпека.  

Щоб надійно й безпечно користуватись електроенергією, потрібно знати, 

якою є напруга у мережі, і на якій напрузі працює те чи інше 

електроустаткування.  

Джерелом небезпеки при роботі на комп`ютері є напруга живлення 220-380 

В. За ступенем електричної небезпеки згідно ПУЭ (Правила устройства 

электроустановок) [18] дане приміщення відноситься до першого класу: 

приміщення без підвищеної небезпеки. До заходів захисту від дії електричного 

струму застосовують технічні засоби захисту – це пристрої, що слугують для 

захисту людини від ураження електричним струмом. До них належать: 

 ізоляція струмопровідних частин; 

 недоступність для випадкового дотику до струмопровідного 

устаткування; 

 захисне заземлення. 

Захист об`єкта дослідження від прямих ударів блискавки забезпечується 

встановленими блискавковідводами. Захист від електростатичної індукції 

(вторинний прояв блискавки) здійснюється приєднанням устаткування до 

заземлювача для відведення електростатичних зарядів, індукованих блискавкою, в 

землю. 
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4.1.2 Мікроклімат (метеорологічні умови) 

 

 

Розглянемо більш детально шкідливі фактори, які впливають на об`єкт 

дослідження. За важкістю робіт кабінет відноситься до категорії Iа – робота, що 

виконується сидячи, енерговитрати – 135 Вт. 

Однією з необхідних умов здорової та високопродуктивної праці є 

забезпечення чистоти повітря та нормальних метеорологічних умов у робочій 

зоні.  

При експлуатації електронних обчислювальних машина вологість повітря в 

приміщенні згідно ДНАОП 0.03-3.15-86 [19] повинна бути 40-60%, оптимальною 

температурою вважають: 22-24 
0
С для холодного періоду року та 23-25 

0
С у 

теплий період, відносна вологість - 40-60 %, рухливість повітря не більше 0,1 м/с, 

запиленість повітря - не більше 0,75 мг/м
3
 при розмірах частинок не більше 3 мкм. 

Для забезпечення встановлених норм мікроклімату в кабінеті застосовують 

природню вентиляцію. 

Фактичні параметри мікроклімату в кабінеті є в межах норми. У приміщенні 

відсутні джерела забруднення повітряного середовища. 

 

 

4.1.3 Освітлення 

 

 

Згідно ДБН В.2.5-28-2006 [20] в робочому кабінеті застосовується система 

комбінованого освітлення. При виконанні робіт категорії високої зорової точності 

(найменший розмір об'єкта розрізнення 0,4 мм) величина коефіцієнта природного 

освітлення (КПО) 1,5%, а при зоровій роботі середньої точності (найменший 

розмір об'єкта розрізнення 0,7 мм) КПО 1,0%. У якості джерел штучного 

освітлення використовуються підвісні люмінесцентні світильники на 4 лампи по 

40 Вт в кількості 2 шт. Світильники призначені для роботи при нормальних 
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параметрах мікроклімату в приміщенні. Коефіцієнти відбиття від стелі 70%, від 

стін 50%, від підлоги 10%. 

Вимоги до освітленості в приміщенні, де встановлені комп'ютери, наступні: 

 при виконанні зорових робіт високої точності загальна освітленість 300 

Лк, а комбінована – 750 Лк;  

 аналогічні вимоги при виконанні робіт середньої точності - 200 і 300 Лк 

відповідно.  

Робоче місце працівників складається зі столу, з розміщеним на ньому 

екраном, клавіатурою, принтером, сканером та крісла. Висота робочого столу 

0,68...0,84 м. Саме в цій площині повинна забезпечувати достатня освітленість. 

 

 

4.1.4 Шум  

 

 

Джерелами шуму при роботі з комп’ютерною технікою є жорсткий диск, 

вентилятор блока живлення мережі, вентилятор розташований на процесорі, 

швидкісні CD-ROM. При роботі вентиляційної системи ПК, яка забезпечує 

оптимальний температурний режим електронних блоків ПК і вмонтована в задню 

панель, створюється аеродинамічний шум. Окрім того діють і інші зовнішні 

джерела шуму, не пов’язані з роботою ПК. 

Рівень шуму в приміщенні не перевищує 50 дБА, що задовольняє вимогам 

ДСН 3.3.6.037-99 [21]. Якщо працівник піддається впливу шуму, то лише на 

короткий час при роботі друкуючих пристроїв. На цій основі робимо висновок, 

що клас допустимий. 

Дія іонізуючих випромінювань і електромагнітних полів 

Допустимі значення параметрів неіонізуючих електромагнітних 

випромінювань від монітора комп'ютера представлені в табл. 4.1 

Максимальний рівень рентгенівського випромінювання на робочому місці 

звичайно не перевищує 10 мкбер/год, а інтенсивність ультрафіолетового і 
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інфрачервоного випромінювання від екрану монітора лежить в межах 

10… 100 мВт/м
2
 . 

Для зниження дії цих видів випромінювання рекомендується застосовувати 

монітори із зниженим рівнем випромінювання (MPR-II, TCO-92, TCO-99), 

встановлювати захисні екрани, а також дотримувати регламентовані режими 

праці та відпочинку. 

 

Таблиця 4.1- Допустимі значення параметрів неіонізуючих 

електромагнітних випромінювань (відповідно до СанПиН 2.2.2.542-96 [22]) 

 

Найменування параметра Допустимі значення 

Напруженість електричної складової 

електромагнітного поля на відстані 50 см від 

поверхні монітора 

10 В/м 

 

Напруженість магнітної складової 

електромагнітного поля на відстані 50 см від 

поверхні монітора 

0,3 А/м 

 

Напруженість електростатичного поля не повинна 

перевищувати: 20 кВ/м 

для дорослих користувачів 

 

 

4.1.5 Пожежна небезпека 

 

 

Причинами виникнення пожеж може бути  коротке замикання, 

перевантаження мереж, несправність обладнання.  

Відповідно до ОНТП24-86 [23] та НАПБ Б.03.002-2007 [24] робочий кабінет 

відноситься до категорії В (пожежонебезпечна). 
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Для ліквідації невеликих осередків пожеж, а також для гасіння пожеж у 

початковій стадії їх розвитку силами персоналу об'єкту застосовуються первинні 

засоби пожежогасіння. До них відноситься: вуглекислотний вогнегасник. Як 

правило, первинні засоби пожежогасіння розміщуються на пожежних щитах або 

стендах. 

 

 

4.2 Перевірка природнього та штучного освітлення  

 

 

4.2.1 Перевірка природнього освітлення 

 

 

Розрахункові дані наведені у таблиці 4.2. 

 

Таблиця 4.2 – Розрахункові дані 

Показник 

Габарити приміщення:  

- довжина 10 

- ширина 7,5 

- висота 4 

Розміри віконного прорізу:  

- висота 2,0 

- ширина 2,5 

Кількість вікон 3 

Висота від підлоги до підвіконня, м 0,5 

Вікна розташовані вздовж більшої стіни + 

Середньозважений коефіцієнт відбиття внутрішніх поверхонь 0,5 

Найбільша відстань від вікна до робочого місця, м 5 

Вид джерела світла л/л 

Кількість світильників 9 

Кількість ламп у світильнику 4 
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Нормоване значення коефіцієнта природного освітлення (КПО) для 

четвертого світлового поясу України, еIV, визначається за формулою: 

 

cmIIIнIV ee
,      (4.1) 

 

де енІІІ - значення КПО для III світлового поясу за СНиП II-4-79 [25]; 

m - коефіцієнт світлового клімату (для України m = 0,9); 

c - коефіцієнт сонячності. Для географічної широти міста Суми розташоване 

в межах 0,75-1,0, приймемо с = 0,75. 

Для більшості адміністративно-управлінських приміщень, у яких 

виконуються роботи III розряду (середньої точності), для бокового освітлення 

енІІІ = 1,5%; 

 

еIV = 1,5·0,9·0,75 = 1,01 % 

 

Фактичне значення коефіцієнта природного освітлення для досліджуваного 

приміщення можна вивести з формули: 

 

здзon

oo
ф

ККS

rS
е 1100

 ,     (4.2) 

 

де  S
o
 – площа усіх вікон у приміщенні, м

2
;  

Sn – площа підлоги приміщення, м
2
;   

τo – загальний коефіцієнт світлопроникності. Для віконних прорізів 

адміністративно-управлінських будівель, які не обладнані сонцезахисними 

пристроями, τo = 0,5; 

Кзд – коефіцієнт, що враховує затемнення вікон іншими будинками, якщо 

будинків немає, то Кзд = 1; 

Кз – коефіцієнт запасу береться в межах Кз = 1,3 – 1,5, приймаємо Кз= 1,4; 
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r1 - коефіцієнт, який враховує відбиття світла від внутрішніх поверхонь 

приміщення. Його значення залежить від розмірів приміщення (довжини і 

ширини), глибини приміщення (відстані від вікна до протилежної йому стінки), 

висоти від верху вікна до рівня робочої поверхні, відстані розрахункової точки від 

вікна, середньозваженого коефіцієнта відбиття світла від стін, стелі, підлоги, ρсг. 

Для світлих приміщень із світлими меблями ρсг можна орієнтовно взяти таким, 

що дорівнює 0,5, для темних – 0,3, для посередніх між ними – 0,4. Приймаємо 0.5.  

Визначимо коефіцієнт  , для чого визначаємо наступні параметри. 

Відношення глибини приміщення (7,5 м) до висоти від рівня умовно 

робочої поверхні (рівень робочого столу  - 0,8 м) до верху вікна:  

 

 

 

Рисунок 4.1 – Схема природного освітлення приміщення 

 

Відношення відстані розрахункової точки від зовнішньої стіни (найбільше 

віддалення робочого місця від вікна – 5 м) до глибини приміщення (7,5 м) 

дорівнює: 
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Відношення довжини приміщення до його глибини дорівнює: 

 

 

 

Для таких параметрів значення   r1 =4,37 

ηo – світлова характеристика вікна, ηo= 20; 

 

 

 

Так як значення нормованого коефіцієнта природного освітлення 

(eIV=1,01 %) менше фактичного освітлення (еф=1,56 %), то природне освітлення у 

кімнаті ефективне та заходи щодо поліпшення природнього освітлення в 

приміщенні не потрібні. 

 

 

4.2.2 Перевірка штучного освітлення 

 

 

Штучне освітлення у приміщенні забезпечується 9 світильниками з 4-ма 

люмінесцентними лампами в кожному світильнику. Світильники розташовуються 

в три ряди по 3 штуки. 

Світловий потік, створюваний джерелами штучного освітлення 

визначається за формулою: 

 

,
ZKS

nNF
E ВЛ

Ф

                                                 (4.3) 

 

де Fл - світловий потік лампи, лм; Люмінесцентні лампи типу ЛБ 40, 

Fл=3120 Лм; 
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hВ - коефіцієнт використання світлового потоку; Для світильників, які 

використовуються в адміністративних будівлях для традиційних розмірів 

приміщення і кольорового оздоблення, може набувати значення в межах ηв= 0,4 – 

0,6, приймаємо ηв = 0,5; 

N - число світильників в приміщенні, шт; N=9 шт. 

n - кількість ламп у світильнику, шт; n=4 шт. 

S - площа приміщення, S =  75 м
2
; 

K - коефіцієнт запасу (К = 1,5÷2) приймаємо 2; 

Z - коефіцієнт нерівномірного освітлення для люмінесцентних ламп, 

(становить 1,1). 

Для освітлення застосовуються люмінесцентні лампи потужністю 40 Вт. 

Світловий потік цих ламп становить до 3120 лм.  

 

 

 

Нормоване значення освітлення для адміністративно-управлінських 

приміщень при використанні люмінесцентних ламп, при загальному освітленні 

відповідно до СНиП II-4-79 [25] має становити 300 лк. Таким чином, загальне 

освітлення відділу достатнє. 

 

 

4.3 Безпека в надзвичайних ситуаціях на досліджуваному об’єкті  

 

 

До надзвичайних ситуацій, що можуть виникнути на обстежуваному об’єкті 

можна віднести пожежі. Можливі такі причини виникнення пожеж: 

 спалах від електричної іскри; 

 проблеми з проводкою; 

 пожежа у лісосмузі, що знаходиться поряд з обстежуваним об’єктом. 
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Порядок дій персоналу у разі виникнення пожежі: 

1. При виникненні пожежі дії працівників, залучених до її гасіння, мають 

бути спрямовані на створення безпеки працівників та відвідувачів, їх евакуацію та 

рятування. 

2. Кожний працівник, який виявив пожежу або її ознаки (задимлення, запах 

горіння або тління різних матеріалів, підвищення температури у приміщенні 

тощо), зобов’язаний: 

- негайно повідомити про це пожежну частину ( при цьому слід чітко 

назвати адресу об’єкта, місце виникнення пожежі, а також свою посаду та 

прізвище); 

- задіяти систему оповіщення людей про пожежу; 

- розпочати самому і залучити інших до евакуації людей із будівлі до 

безпечного місця згідно з планом евакуації; 

- сповістити про пожежу керівника закладу або його заступника. 

3. Начальник, його заступник, який прибув на місце пожежі, зобов’язаний: 

- перевірити чи повідомили пожежну охорону про виникнення пожежі; 

- здійснити керівництво, евакуацію людей та гасіння пожежі до прибуття 

пожежних підрозділів. організувати перевірку наявності всіх людей, 

евакуйованих із будівлі за списками; 

- виділити для зустрічі пожежних підрозділів особу, яка добре знає 

розміщення  під’їздних шляхів або вододжерел; 

- вивести з небезпечної зони всіх працівників, не зайнятих ліквідацією 

пожежі; 

- при необхідності викликати до місця пожежі медичну та інші служби; 

- припинити всі роботи, не пов’язані із заходами щодо ліквідації пожежі; 

- організувати відключення мереж електро- і газопостачання, зупинку 

системи вентиляції та кондиціонування повітря і здійснення інших заходів, які 

сприяють запобіганню  поширення пожежі; 
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- забезпечити безпеку людей, які беруть участь в евакуації та в гасінні 

пожежі від можливих обвалів конструкцій, дії токсичних продуктів горіння і 

підвищених температур, уражених електрострумом тощо; 

- організувати евакуацію матеріальних цінностей із небезпечної зони, 

визначити місця їх складання і забезпечити, при потребі, їх охорону; 

- інформувати керівника пожежного підрозділу про наявність людей у 

будівлі. 

4. Під час проведення евакуації та гасіння пожежі необхідно: 

- з урахуванням обстановки, що склалася, визначити найбезпечніші  

евакуаційні шляхи і виходи до безпечної зони у найкоротший термін; 

- евакуацію людей слід починати з приміщення, в якому виникла пожежа, і 

в суміжних з ним приміщень, яким загрожує небезпека поширення вогню і 

продуктів горіння; 

- виставити пост безпеки біля входу у будівлю, щоб працівники не 

повертались туди, де виникла пожежа; 

- при гасінні слід намагатися в першу чергу забезпечити сприятливі умови 

для безпечної евакуації людей; 

- слід утримуватись від відчинення вікон і дверей, а також від розбивання 

скла, щоб зменшити ймовірність поширення вогню і диму до суміжних 

приміщень. 
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ВИСНОВОК 

 

 

У магістерській роботі вивчався вплив просторової форми будівлі на 

ефективність її опалення методом модельного розрахунку. 

У ході роботи вирішені ряд задач: 

– встановлено оптимальні параметри мікроклімату приміщення для 

забезпечення комфортних умов перебування людини; 

– розроблено математичну та числову модель теплового стану 

приміщення з обігрівом; 

– проведено моделювання процесів аеродинаміки та тепломасообміну в 

приміщенні для аналізу його теплового стану; 

– визначено раціональну просторову форму будівлі, що забезпечує 

комфортні умови перебування людини в приміщенні. 

При виконанні дослідження були розглянуті та проаналізовані чотири 

просторових форми будівлі, а саме: 

– сферична;   

– циліндрична; 

– пірамідальна;   

– прямокутна.  

Сферична форма будівлі має найкращі показники по розподілу температури 

в кімнаті так як біля стелі не має кутів, а тому тепле повітря максимально 

рівномірно прогріває весь внутрішній просторовий об’єм приміщення. 
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